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Denne vejledning er et supplement til Brugervejledningen og indeholder forklaringer af funktionerne i Menu-displayet. Sørg for at 
læse Brugervejledningen først for at forstå den grundlæggende betjening, før du læser denne Referencevejledning.
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Grundlæggende betjening på Menu-displayet

Hvis du trykker på [MENU]-knappen, vises Menu-displayet. Menu-displayet indeholder fem menuer og gør det muligt at foretage 
indstillinger i forbindelse med Voice (Lyd), Song (Melodi), Metronome/Rhythm (Metronom/rytme), Recording (Indspilning) og 
System (generelle indstillinger for instrumentet). I dette afsnit forklares de grundlæggende handlinger i Menu-displayet.
For det følgende skal du foretage yderligere indstillinger, før du åbner Menu-displayet.

• Når du ønsker at redigere lydrelaterede parametre:
Vælg en lyd. Hvis du ønsker at redigere lyde i dobbelt/split/firhændig i samme oktav, skal du aktivere den ønskede funktion.

• Når du ønsker at redigere melodirelaterede parametre:
Vælg en melodi.

1. Tryk på [MENU]-knappen flere gange for at vælge den ønskede menu.
Du skifter mellem menuerne ved at trykke gentagne gange på knappen. Menunavnet øverst på displayet og ikonet til venstre
angiver den valgte menu.

2. Brug [u]/[d]/[l]/[r]-knapperne til at vælge den ønskede parameter.

3. Brug [l]/[r]-knapperne til at ændre indstillingen eller udføre handlingen.
For at nulstille det valgte element til standardværdien på CLP-885, CLP-875 og CLP-895GP skal du trykke på og holde
[MENU]-knappen nede, indtil værdien er nulstillet. På CLP-845, CLP-835 og CLP-865GP skal du trykke på knapperne [<] og
[>] samtidigt. 

4. Tryk på [EXIT]-knappen for at lukke Menu-displayet.

Voice-menuen side 3
Til ændring af indstillingerne for spil på tangenterne (pedalfunktion, 
volumenbalance i dobbelt/split/firhændig i samme oktav, transponere osv.) 
samt redigering af lyde.

Song-menuen side 9
Til ændring af indstillingerne for afspilning af melodier (gentag afspilning, 
volumen, transponere osv.), til redigering af melodier samt håndtering af 
melodifiler.

Metronome/Rhythm-
menuen

side 16
Til justering af volumen for metronom og rytme, indstilling af metronomens 
taktart samt rytmerelaterede indstillinger.

Recording- 
menuen

side 18 Til angivelse af indstillinger i forbindelse med MIDI-indspilning.

System-menuen side 20
Til angivelse af indstillinger for hele instrumentet (tuning, lyd, automatisk 
slukning, displayets lysstyrke osv.), formatering af et USB-flashdrev og 
sikkerhedskopiering af instrumentindstillingerne.

885 875 895GP 845 835 865GP
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Voice-menuen

Med Voice-menuen (Lyd) kan du redigere eller indstille forskellige parametre relateret til spillet på tangenterne, f.eks. lydparametre. Når du spiller 
på klaviaturet og lytter til lyden, kan du ændre parameterværdier én efter én for at finde din ønskede lyd. Når du indstiller lyde i Dual, Split eller Duo 
(hhv. Dobbelt, Split eller Firhændig i samme oktav), skal du sørge for at slå Dual, Split eller Duo til, før du åbner Voice-menuen (Lyd).

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling

Transpose (Transponere) Ændrer tonehøjden for hele instrumentet op eller ned 
i halvtoneintervaller, så det bliver lettere at spille 
i vanskelige tonearter, og så du lettere kan tilpasse 
klaviaturets tonehøjde til en sanger eller andre 
instrumenter. Hvis du f.eks. indstiller denne parameter 
til "5", får du tonehøjden F, når du spiller tonearten C. På 
den måde kan du spille melodien i F-dur, som om den 
var i C-dur.

BEMÆRK
• Denne indstilling påvirker ikke afspilningen af melodier. Hvis du 

vil transponere melodiafspilningen, skal du bruge parameteren 
"Transpose" (Transponere) i Song-menuen (Melodi) (side 10).

• Ved lydindspilning indspilles den transponerede lyd i henhold til 
indstillingen her. Ved MIDI-indspilning balanceres "Transpose"-
værdien (Transponere) i Song-menuen (Melodi) (side 10) fra 
indstillingen her.

• Dit spil på tangenterne overføres med de transponerede 
tonenumre, mens de MIDI-tonenumre, der modtages fra en ekstern 
MIDI-enhed eller computer, ikke påvirkes af 
transponeringsindstillingen.

-12 (-1 oktav) – 0 
(normal tonehøjde) – 
+12 (+1 oktav)

0

Piano Setting 
(Piano-
indstilling)
* Disse indstillinger 

virker kun for de 
klaverlyde, der har 
VRM-effekter.

Lid Position 
(Lågets 
position)

Genskaber forskellene i lyd afhængig af, hvor højt det 
(virtuelle) flygellåg er åbnet.

Full (Helt), Half (Halvt), 
Close (Lukket)

Full (Helt)

VRM Slår VRM-effekten til/fra.

 VRM (Virtual Resonance Modeling)
Virtual Resonance Modeling-funktionen (VRM) anvender 
sofistikeret fysisk modellering til at simulere den egentlige lyd af 
strengresonans, der opstår, når dæmperpedalen på et rigtigt 
piano trykkes ned, eller når der spilles og holdes på 
tangenterne. Hvis du trykker på dæmperpedalen på et rigtigt 
akustisk piano og slår en tangent an, vibrerer ikke alene 
strengen for den tangent, du trykkede på, men også andre 
strenge og sangbunden, og det vil påvirke helheden og skabe 
en fyldig og klar resonans, der spredes og giver efterklang. 
VRM-teknologien, som dette instrument har, gengiver den 
komplicerede interaktion af såvel streng- som 
sangbundsresonans på en naturtro måde vha. et virtuelt 
musikinstrument (fysisk modellering) og får lyden til at lyde som 
et ægte akustisk klaver. Da resonansen frembringes her og nu i 
øjeblikket i henhold til klaviaturets eller pedalens tilstand, kan du 
variere lydudtrykket ved at ændre dine anslags timing og 
timingen og dybden af dit tryk på pedalen.

Når "VRM" er On (Til), kan du indstille følgende 
parametre som ønsket.

On (Til), Off (Fra) On (Til)

Damper Res.
(Dæmper- 
resonans)

Bestemmer dybden for den 
strengresonanseffekt, som anvendes 
for pianolydene, når du trykker på 
dæmperpedalen (højre pedal).

0-10 5
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Voice-menuen
Piano Setting 
(Piano-
indstilling)
* Disse indstillinger 

virker kun for de 
klaverlyde, der har 
VRM-effekter.

VRM Damper 
Noise 
(Dæmperstøj)

Slår Damper Noise (Dæmperstøj) til/
fra. Denne funktion er deaktiveret, når 
"Damper Res." (Dæmperresonans) 
er indstillet til 0.

 Damper Noise (Dæmperstøj)
Dæmperstøjen er den lyd, der frembringes 
på et akustisk piano, når dæmperpedalen 
trykkes ned. Dæmperstøjen skifter tone og 
volumen afhængigt af, hvor hurtigt 
dæmperpedalen trykkes ned. Hvis 
dæmperpedalen trykkes langsomt ned, 
frembringes der en lavere lyd, når 
dæmperne slippes fra strengene. Når 
dæmperpedalen trykkes hårdt ned, 
overføres vibrationerne til strengene, 
hvilket giver en lavere og højere lyd.

On (Til), Off (Fra) On (Til)

String Res.
(Streng- 
resonans)

Bestemmer dybden for den 
strengresonanseffekt, som anvendes, 
når du spiller en tone på klaviaturet.

0-10 5

Duplex 
Scale Res.
(Duplexska-
laresonans)

Justerer de behagelige vibrationer 
ved effekten duplexskalaresonans.

 Duplex Scale (Duplexskala)
Duplexskala er en strengmetode til 
pianoer, der anvender ekstra strenge uden 
anslag i de øvre oktaver for at forstærke 
tonen. Strengene vibrerer behageligt med 
andre strenge i et akustisk piano, 
resonerer med overtoner og tilfører fylde, 
brilliance og kompleks farverigdom til 
lyden. Da dæmperne ikke berører dem, 
fortsætter de med at give lyd, efter du har 
fjernet hænderne fra klaviaturet.

0-10 5

Body Res. 
(Piano- 
resonans)

Tilpasser selve pianoets resonans 
(sangbunden, siderne, rammen osv.).

0-10 5

Grand Exp. 
(Grand 
Expression-
modellering)

Vælger typen af Grand Expression Modeling-effekter, 
hvilket simulerer de fysiske lydovergange fra et rigtigt 
piano. Når denne funktion er indstillet til "Dynamic" 
(Dynamisk), kan du styre ekstremt fine nuancer i det, du 
spiller, og lyden ved at ændre spillestyrken, berøringen 
eller den måde, du slipper tangenterne på. Når 
funktionen er indstillet til "Statisk", er nuancerne 
generelt uændrede.

 Grand Expression Modeling (Grand 
Expression-modellering)

På et rigtigt akustisk piano kan du skabe hårfine ændringer 
i lyden ved at ændre dit anslag, fra når du trykker på tangenten, 
til når du slipper den. Når du f.eks. trykker en tangent helt ned, 
rammer tangenten tangentbunden underneden, og lyden når 
strengene, hvilket ændrer lyden en lille smule. Når dæmperen 
sænkes ned på strengene for at dæmpe lyden, skifter klangen, 
alt efter hvor hurtigt du slipper tangenten. Teknologien til Grand 
Expression-modellering genskaber disse hårfine ændringer 
i lyden, så de svarer til dit anslag. Det betyder, at du kan 
fremhæve betoninger ved at spille kraftigt, eller du kan 
fremhæve resonans ved at spille blødt, så der dannes en fin, 
udtryksfuld lyd. En sprød klang kan høres, når du spiller 
staccato, og en lang lyd dannes, når tangenterne slippes 
langsomt.

Dynamic (Dynamisk), 
Static (Statisk)

Dynamic (Dynamisk)

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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Voice-menuen
Reverb (Rumklang) Bestemmer den rumklangstype, som anvendes for al 
lyden, herunder spil på tangenterne, melodiafspilning 
og MIDI-datainput fra en ekstern MIDI-enhed.
• Off (Fra): Ingen effekt:
• Recital Hall (Mellemstor koncertsal): Simulerer den 

naturlige efterklang i en mellemstor koncertsal til 
pianokoncerter.

• Concert Hall (Stor koncertsal): Simulerer den klare 
efterklang i en stor koncertsal til offentlige orkesterkoncerter.

• Chamber (Kammer): Simulerer den elegante efterklang i et 
lille lokale, der er velegnet til kammermusik.

• Room (Rum): Simulerer den bløde efterklang på et mindre 
sted til optrædener, f.eks. et rum eller en lounge.

• Cathedral (Katedral): Simulerer den højtidelige efterklang 
i en højloftet katedral bygget af sten.

• Club (Klub): Simulerer den livlige efterklang i en jazzklub 
eller en lille bar.

• Plate (Plade): Simulerer den skarpe lyd af klassisk 
rumklangudstyr, som bruges i lydstudier.

(Se kolonnen 
til venstre.)

(Varierer afhængigt 
af lyden eller 
kombinationen 
af lyde.)

Chorus (Kor) Bestemmer den Chorus-type (Kor), som anvendes for 
al lyden, herunder spil på tangenterne, melodiafspilning 
og MIDI-datainput fra en ekstern MIDI-enhed.
• Off (Fra): Ingen effekt:
• Chorus (Kor): Giver en fyldig, rummelig lyd.
• Celeste (Celesta): Giver "orgelbrus" og en rummelig lyd.
• Flanger (Flanger): Giver en bølgende effekt som fra et 

opadgående og nedadgående jetfly.

(Se kolonnen 
til venstre.)

(Varierer afhængigt 
af lyden eller 
kombinationen 
af lyde.)

Voice Edit 
(Lydredi-
gering)

Hvis du ændrer indstillingerne nedenfor, kan du redigere lyden af den valgte lyd som ønsket. 
Når Dual (Dobbelt), Split (Split) eller Duo (Firhændig i samme oktav) er slået til, vises flere lydnavne på "Voice Edit"-
displayet (Lydredigering). Vælg den ønskede lyd, og rediger den. 

• Når Dual (Dobbelt) er slået til: øvre kolonne = Lyd 1, nedre kolonne = Lyd 2
• Når Split (Split) er slået til: øvre kolonne = Højre lyd, nedre kolonne = Venstre lyd
• Når Dual og Split er slået til: øvre kolonne = Højre lyd 1, midterkolonne = Højre lyd 2, nedre kolonne = Venstre lyd
• Når Duo (Firhændig i samme oktav) er slået til: øvre kolonne = Lyd til højre spiller, nedre kolonne = Lyd til venstre spiller

Octave 
(Oktav)

Ændrer instrumentets tonehøjde op eller ned i oktavtrin. -2 – 0 (intet pitch shift) 
– +2

(Varierer afhængigt 
af lyden eller 
kombinationen 
af lyde.)

Volume 
(Volumen)

Justerer volumenen for den valgte lyd. 0-127

Reverb Depth 
(Rumklang-
sdybde)

Justerer dybden af den valgte rumklangstype.  
Hvis indstillingen 0 bruges, er der ingen effekt.

BEMÆRK
Når der bruges en VRM-lyd til flere stemmer samtidigt, kan der opstå 
uventede lyde. Det skyldes, at rumklangsdybden for en stemme, som 
er prioriteret, bliver anvendt på alle stemmer. Under melodiafspilning 
bruges en indstilling for en melodistemme (prioriteret rækkefølge: 
Kanal 1, kanal 2...kanal 16), mens indstillingen for en 
klaviaturstemme bruges, når melodiafspilningen stoppes (prioriteret 
rækkefølge: R1-, L- og R2-lyde).

0-127

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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Voice-menuen
Voice Edit 
(Lydredigering)

Chorus Depth 
(Styrke af 
korlyd)

Justerer dybden af den valgte Chorus-type (kortype). 
Hvis indstillingen 0 bruges, er der ingen effekt.

BEMÆRK
Når der bruges en VRM-lyd til flere stemmer samtidigt, kan der opstå 
uventede lyde. Det skyldes, at rumklangsdybden for en stemme, som 
er prioriteret, bliver anvendt på alle stemmer. Under melodiafspilning 
bruges en indstilling for en melodistemme (prioriteret rækkefølge: 
Kanal 1, kanal 2...kanal 16), mens indstillingen for en 
klaviaturstemme bruges, når melodiafspilningen stoppes (prioriteret 
rækkefølge: R1-, L- og R2-lyde).

0-127 (Varierer afhængigt 
af lyden eller 
kombinationen 
af lyde.)

Effect (Effekt) Bestemmer effekttypen. Rumklang og Chorus (kor) 
anvendes på hele lyden, mens den effekt, der er valgt 
her, kun anvendes på den valgte lyd. Det er ikke muligt 
at anvende effekter på VRM-lydene.
• Off (Fra): Ingen effekt:
• DelayLCR (Forsink venstre, midterste, højre): 

Forsinkelse anvendes i venstre, midterste og højre position.
• DelayLR (Forsink venstre, højre): Forsinkelse anvendes 

i venstre og højre position.
• Echo (Ekko): Ekkolignende forsinkelse.
• CrossDelay (Krydsforsink): De venstre og højre 

forsinkelser krydser hinanden skiftevis.
• Symphonic (Symfonisk): Giver en fyldig og kraftig akustisk 

effekt.
• Rotary (Rotation): Giver vibrato-effekt som af en roterende 

højttaler.
• Tremolo (Tremolo): Lydstyrken ændrer sig hurtigt periodisk.
• VibeRotor (Vibrationsrotor): Vibrato-effekt som af en 

vibrafon.
• AutoPan (Automatisk panorering): Lyden panorerer frem 

og tilbage mellem venstre og højre.
• Phaser (Phaser): Fasen ændrer sig periodisk, så lyden 

bølger op.
• AutoWah (Automatisk Wah): Wah-filterets centerfrekvens 

ændrer sig periodisk.
• Distortion (Forvrængning): Forvrænger lyden.

(Se kolonnen 
til venstre.)

Rotary Speed 
(Rotations- 
hastighed)

Kun tilgængelig, når "Rotary" (Rotation) er valgt som 
effekttype. Denne parameter fastsætter 
rotationshastigheden for den roterende højttalereffekt.

Fast (Hurtig), Slow 
(Langsom)

VibeRotor 
(Vibration-
srotor)

Kun tilgængelig, når "VibeRotor" (Vibrationsrotor) er 
valgt som effekttype. Denne parameter slår VibeRotor-
effekten til eller fra.

On (Til), Off (Fra)

VibeRotor 
Speed 
(Hastighed  
af vibration-
smotor)

Kun tilgængelig, når "VibeRotor" (Vibrationsrotor) er 
valgt som effekttype. Denne parameter fastsætter 
vibratohastigheden for vibrafoneffekten.

1-10

Effect Depth 
(Effektdybde)

Justerer dybden af effekten for den valgte lyd. Visse 
effekttyper tillader ikke justering af dybde.

1-127

Pan 
(Panorering)

Justerer stereopanoreringen for den valgte lyd. L64 (længst til venstre) 
– C (midten) – R63 
(længst til højre)

Harmonic 
Cont
(Harmonisk 
indhold)

Producerer en særlig høj tone ved at hæve 
resonansværdien for filteret.

BEMÆRK
Justering af harmonisk indhold vil i forbindelse med nogle lyde kun 
have en ringe eller slet ingen hørbar effekt.

-64 – +63

Brightness 
(Klarhed)

Justerer klarheden af den valgte lyd. -64 – +63

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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Voice-menuen
Liste over pedalfunktioner

Dette er en liste over de funktioner, der kan tildeles den venstre, højre og midterste pedal fra "Pedal Assign" (Tildel pedal) i lydmenuen. De 
funktioner, der kan tildeles, varierer afhængigt af pedalen.

Voice Edit 
(Lydredigering)

Touch Sens.
(Grad af 
anslagsføl-
somhed)

Bestemmer, i hvor høj grad lydstyrken ændrer sig som 
reaktion på dit anslag på klaviaturet (hvor hårdt du 
spiller). Eftersom volumenen for visse lyde, f.eks. 
Harpsichord og Organ, ikke ændrer sig med anslaget, 
er standardindstillingen for disse lyde 127.

0 (laveste) – 64 
(største ændringer 
af niveauet) – 127 
(højeste, uanset 
hvordan du spiller 
på klaviaturet).

(Varierer afhængigt 
af lyden eller 
kombinationen 
af lyde.)

RPedal (Højre 
pedal)

Slår funktionen af højre, venstre og midterste pedal til/
fra for den valgte lyd. Denne parameter er nyttig, når 
du f.eks. vil sikre, at pedalfunktionen påvirker 
højrehåndsspil, men ikke venstrehåndsspil, når Split 
er slået til. 

On (Til), Off (Fra)

CPedal 
(Midterste 
pedal)

LPedal 
(Venstre 
pedal)

Pedal Assign 
(Tildel pedal)

Right (Højre) Ændrer funktionerne af den højre, venstre og midterste 
pedal.

BEMÆRK
Standardindstillingen af den venstre pedal varierer for visse lyde: 
"Rotary Speed" (Rotationshastighed) for lydene "Jazz Organ 1" 
(Jazzorgel 1), "Jazz Organ 2" (Jazzorgel 2) eller "Rock Organ" 
(Rockorgel) og "VibeRotor" (Vibrationsrotor) for lyden "Vibraphone" 
(Vibrafon).

(Se listen over 
pedalfunktioner 
nedenfor.)

Sustain (Cont.) 
(Efterklang 
(Kontinuerlig))

Center 
(Midter)

Sostenuto

Left (Venstre) Lav

Balance
* Det er kun de 

tilgængelige 
parametre, der 
vises, når Dual 
(Dobbelt), Split 
(Split) eller Duo 
(Firhændig 
i samme oktav) 
er slået til.

Volume 
(Volumen)  
R2 – R1

Justerer volumenbalancen mellem to lyde, når 
dobbelttilstand er slået til. Hvis skyderen flyttes til højre, 
stiger Højre 1-volumen og sænker Højre 2-volumen og 
omvendt.

R2+10 – 0 – R1+10 (Varierer afhængigt 
af lyden eller 
kombinationen 
af lyde.)

Volume 
(Volumen)  
L – R (V – H)

Justerer volumenbalancen mellem højre og venstre 
stykker, når Split eller Firhændig i samme oktav er slået 
til. Hvis skyderen flyttes til højre, stiger volumen af højre 
stykke og sænker volumen af venstre stykke og 
omvendt.

L+10 – 0 – R+10

Detune 
(Forstemme)

Forstemmer Højre lyd 1 og Højre lyd 2 i Dual (Dobbelt) 
for at skabe en tættere lyd. Hvis skyderen flyttes til højre, 
stiger tonehøjden af Højre lyd 1 og sænker tonehøjden 
af Højre lyd 2 og omvendt.

R2+20 – 0 – R1+20

Funktion Beskrivelse Kan tildeles (: Ja, –: Nej)

Venstre 
pedal

Midter-
pedal

Højre 
pedal

Sustain (Switch) 
(Efterklang 
(kontakt))

Bevarer de toner, du spiller, mens du trykker på pedalen, selv efter du 
slipper dine fingre fra klaviaturet.

  

Sustain (Cont.) 
(Efterklang 
(Kontinuerlig))

Bevarer de toner, du spiller, mens du trykker på pedalen, selv efter du 
slipper dine fingre fra klaviaturet. Længden af efterklangen varierer, 
afhængigt af hvor langt ned pedalen trykkes.

– – 

Sostenuto Hvis du spiller en tone eller en akkord og trykker pedalen ned, mens 
du holder tonen, bliver tonen ved med at klinge, så længe pedalen 
holdes nede. Men de efterfølgende toner klinger ikke længere. 

  

Soft (Lav) Reducerer volumen og ændrer klangfarven ændres en smule, mens 
pedalen holdes nede.

  

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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Voice-menuen
BEMÆRK
• For visse lyde, f.eks. strenge og orgel, kan lyden bevares kontinuerligt, når der trykkes på pedalen (som er tildelt dæmper-/sostenutofunktionen).
• Hvis [PLAY/PAUSE]-funktionen er tildelt en pedal via "Pedal" > "Play/Pause" (Pedal > Afspil/pause) i System-menuen (side 22), deaktiveres den tilsvarende pedals 

funktion, som er tildelt her.

PitchBend Up 
(Ændring af 
tonehøjde op)

Hæver tonehøjden glidende. – – 

PitchBend Down 
(Ændring af 
tonehøjde ned)

Sænker tonehøjden glidende. – – 

Rotary Speed 
(Rotationshastighed)

Skifter hastigheden af den roterende højttaler (for lydene Jazz Organ 1, 
2 eller Rock Organ) mellem "Fast" (Hurtig) og "Slow" (Langsom), hver 
gang du trykker på pedalen.

  

VibeRotor 
(Vibrationsrotor)

Slår vibrato til/fra (for lyden Vibraphone (Vibrafon)), hver gang du 
trykker på pedalen.

  

Funktion Beskrivelse Kan tildeles (: Ja, –: Nej)

Venstre 
pedal

Midter-
pedal

Højre 
pedal
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Song-menuen

Med Song-menuen (Melodi) kan du indstille forskellige parametre for melodiafspilning og redigere melodidata. Vælg en ønsket 
melodi, inden du begynder handlingen.
De tilgængelige parametre varierer mellem MIDI-melodier og lydmelodier. Følgende parametre, som er angivet med "(Audio)", 
kan kun indstilles, når der er valgt en lydmelodi, og parametre med "(MIDI)" kan kun indstilles, når der er valgt en MIDI-melodi. 
"Edit"-parametre kan ikke indstilles for forprogrammerede melodier og lyddemomelodier.

OBS!
"Execute" (Udfør) er en funktion, der redigerer eller ændrer de aktuelle melodidata. Bemærk, at de oprindelige data erstattes af nye data, når der 
trykkes på [r]-knappen. 

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling

Volume (Volumen)
(Audio)

Justerer volumenen for den valgte lydmelodi. 0-127 100

Repeat (Gentag)
(Audio)

Vælger gentagelsestypen for melodiafspilning.

• Off (Fra): Deaktiverer gentagen afspilning. Når 
afspilningen af den valgte melodi når slutningen, 
stopper afspilningen automatisk.

• Single (Enkelt): Afspiller kun den valgte melodi 
gentagne gange.

• All (Alle): Afspiller kontinuerligt alle melodier i 
mappen, som indeholder den valgte melodi, i 
numerisk rækkefølge.

• Random (Tilfældig): Afspiller kontinuerligt alle 
melodier i mappen, som indeholder den valgte 
melodi, i tilfældig rækkefølge.

Når en anden gentagelsestype end Off (Fra) er 
valgt, vises statusikonet (Single (Enkelt): , 
All (Alle): , Random (Tilfældig): ) øverst 
til højre på Song-displayet (Melodi).

Off (Fra), Single 
(Enkelt), All (Alle), 
Random (Tilfældig)

Off (Fra)

L/R (V/H)
(MIDI)

R (H) Slår hver stemme af den valgte MIDI-melodi til 
(Play) eller fra (Mute). For stemmer, der ikke har 
nogen data, vises "---", og stemmen kan ikke slås 
til eller fra.

BEMÆRK
En MIDI-melodi består af 16 spor (stemmer), og normalt er 
spor 1 tildelt "R", spor 2 tildelt "L", og spor 3-16 er tildelt "Extra".

On (Til), Off (Fra) On (Til)

L (V)

Extra 
(Ekstra)

Repeat 
(Gentag)
(MIDI)

A – B Lader dig afspille et bestemt område (fra punkt A 
til B) af den valgte MIDI-melodi gentagne gange.

1. Tryk på [PLAY/PAUSE]-knappen for at starte 
afspilning af melodien.

2. Tryk på [r]-knappen ved startpunktet (A) af 
det område, der skal gentages.

3. Tryk på [r]-knappen igen ved slutpunktet 
(B). Efter en automatisk indtælling (der 
hjælper dig med at komme i gang) gentages 
området fra punkt A til punkt B.

Hvis du vil deaktivere AB-gentagelsesfunktion, 
skal du trykke på [r]-knappen i A-B Repeat-
displayet, mens "Repeat Off" (Gentag fra) er 
valgt. AB-gentagelsesfunktion deaktiveres også, 
hvis du vælger en anden melodi.

BEMÆRK
• Hvis du vil angive starten af melodien som startpunkt (A), 

skal du angive punkt A, før du starter afspilning.
• Hvis du vil angive slutningen af melodien som slutpunkt (B) 

skal du afspille indtil slutningen af melodien. Punktet B 
indstilles automatisk, uden at du behøver at trykke på nogen 
knap.

On (Til), Off (Fra) Off (Fra)
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Repeat 
(Gentag)
(MIDI)

Phrase (Figur) Denne parameter kan kun indstilles, når der er valgt 
en MIDI-melodi, som indeholder figurmarkøren. Du kan 
afspille en angivet figur i melodien gentagne gange. 
For at gøre det skal du angive et figurnummer i "Phrase 
Mark" (Figurmarkør) og indstille "Repeat" (Gentag) til 
"On" (Til) og derefter starte afspilningen af melodien. 
Hvis du afspiller melodien, mens "Repeat" (Gentag) 
er "Off" (Fra), rykkes nummeret på figurmarkøren på 
dette display frem, hvilket giver dig mulighed for at 
tjekke figurnummeret på den aktuelt afspillede figur, 
mens du lytter til den.
Når "Repeat" (Gentag) er "On" (Til), vises ikonet for 
gentagelse af figurmarkøren ( ) øverst til højre 
på Song-displayet (Melodi).

On (Til), Off (Fra) Off (Fra)

Song (Melodi) Vælger gentagelsestypen for melodiafspilning.
• Off (Fra): Deaktiverer gentagen afspilning. Når afspilningen 

af den valgte melodi når slutningen, stopper afspilningen 
automatisk.

• Single (Enkelt): Afspiller kun den valgte melodi gentagne 
gange.

• All (Alle): Afspiller kontinuerligt alle melodier i mappen, 
som indeholder den valgte melodi, i numerisk rækkefølge.

• Random (Tilfældig): Afspiller kontinuerligt alle melodier 
i mappen, som indeholder den valgte melodi, i tilfældig 
rækkefølge.

Når en anden gentagelsestype end Off (Fra) er valgt, 
vises statusikonet (Single (Enkelt): , All (Alle): 

, Random (Tilfældig): ) øverst til højre på 
Song-displayet (Melodi).

Off (Fra), Single 
(Enkelt), All (Alle), 
Random (Tilfældig)

Off (Fra)

Volume 
(Volumen)
(MIDI)

Song – 
Keyboard 
(Melodi – 
Klaviatur)

Justerer volumenbalancen mellem lyden af MIDI-
melodiafspilningen og spillet på tangenterne.

Song+64 – 0 – Key+64 
(Melodi+64 – 0 – 
Tangent+64)

0

Song L – R 
(Melodi V-H)

Justerer volumenbalancen mellem højrehåndsstemmen 
og venstrehåndsstemmerne for MIDI-
melodiafspilningen.

L+64 – 0 – R+64 0

Transpose (Transponere) Ændrer tonehøjden for melodiafspilningen op eller ned i 
halvtonetrin. Hvis du f.eks. indstiller denne parameter til 
"5", vil en melodi, der er oprettet i C-dur, afspilles i F-
dur. Denne indstilling påvirker ikke tangentens 
tonehøjde.

BEMÆRK
• Anvendelse af transponering for en lydmelodi kan muligvis ændre 

melodiens tonemæssige kendetegn.
• Lydsignalinputtet fra eksterne enheder transponeres ikke.
• Afspilningsdata for MIDI-melodier overføres med de 

transponerede tonenumre, mens de MIDI-tonenumre, der 
modtages fra en ekstern MIDI-enhed eller computer, ikke påvirkes 
af transponeringsindstillingen.

-12 (-1 oktav) – 0 
(normal tonehøjde) – 
+12 (+1 oktav)

0

File (Fil) Delete (Slet) Dette er filhandlinger, f.eks. sletning, kopiering, flytning 
af de melodier, der er gemt på instrumentet eller det 
tilsluttede USB-flashdrev. Du finder flere oplysninger 
under "Styring af melodifilerne" (side 12).

– –

Copy (Kopiér)
(MIDI)

Move (Flyt)
(MIDI)

MIDI to Audio 
(MIDI til lyd)
(MIDI)

Rename 
(Omdøb)

Delete All 
(Slet alle)

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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Edit (Rediger)
(MIDI)

Quantize 
(Kvantisering)

Tilpasser timingen af hver tone i den valgte MIDI-
melodi. Hvis du f.eks. indspiller en musikfigur i 4/4 tid, 
spiller du den måske ikke fuldstændigt præcist, og dele 
af dit spil kan have været en smule foran eller bagefter 
den præcise timing. Kvantisering er en praktisk måde 
at korrigere for dette på. Du finder flere oplysninger 
under "Quantize (tilpasning af timingen af tonerne)" 
(side 13).

– –

Track Delete 
(Slet spor)

Sletter data for et bestemt spor fra den valgte MIDI-
melodi. Du finder flere oplysninger under "Track Delete 
(sletning af data for et bestemt spor)" (side 14).

– –

Tempo 
Change 
(Temposkift)

Ændrer tempoet af den valgte MIDI-melodi til det 
aktuelle tempo og overskriver dataene. Du finder flere 
oplysninger under "Tempo Change (ændring af 
tempoværdien)" (side 15).

– –

Voice Change 
(Lydskift)

Ændrer lyden for et bestemt spor i den valgte MIDI-
melodi til den aktuelle lyd og overskriver dataene. Du 
finder flere oplysninger under "Voice Change (ændring 
af lyden af et bestemt spor)" (side 15).

– –

Others 
(Andre)
(MIDI)

Quick Play 
(Hurtig 
afspilning)

Dette giver dig mulighed for at angive, om en melodi, 
der begynder midt i en takt eller med pause inden den 
første tone, skal spilles fra den første tone eller fra 
taktens begyndelse (pause eller tom). Dette er nyttigt i 
forbindelse med MIDI-melodier, der starter med en kort 
optakt eller indtælling på et eller to taktslag.

On (Til), Off (Fra) On (Til)

Track Listen 
(Lyt til spor)

Dette giver dig mulighed for kun at afspille ét spor af 
den valgte MIDI-melodi for at lytte til melodiens indhold. 
Det gør du ved at vælge et spor, flytte markeringen til 
"Start" og derefter trykke på [r]-knappen og holde den 
nede for at starte afspilningen fra den første tone. 
Afspilningen fortsætter, hvis du holder [r]-knappen 
nede.

Track 1 (Spor 1) – 
Track 16 (Spor 16)

Track 1 (Spor 1)

Play Track 
(Afspil spor)

Dette giver dig mulighed for at angive sporene for den 
valgte MIDI-melodi til afspilning på dette instrument. 
Når "1&2" er valgt, er det kun spor 1 og 2, der afspilles, 
mens spor 3 til 16 overføres til den tilsluttede enhed via 
MIDI. Hvis du vælger "All" (Alle), afspilles alle spor på 
dette instrument.

All (Alle), 1&2 All (Alle)

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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Styring af melodifilerne

Med "File"-parametrene (Fil) i Song-menuen (Melodi) kan du slette en unødvendig melodi, kopiere den indspillede melodi på 
instrumentet til USB-flashdrevet eller foretage andre handlinger relateret til melodifilen for at styre melodifilerne i kategorien "User" 
(Bruger) eller "USB".

Melodityper og begrænsning af filhandlinger
I følgende tabel kan du se en oversigt over melodityperne og restriktionerne i filhandlinger. Melodityper angives som 
et kategorinavn og et ikon på Song-displayet. 

 : Tilgængelig, –: Ikke tilgængelig 

1. Tilslut et USB-flashdrev til USB [TO DEVICE]-stikket efter behov.

2. Vælg en melodi, der skal håndteres.

3. Vælg den ønskede handling under "File" (Fil) i Song-menuen (Melodi).

Betjening Beskrivelse Meloditype

Kategori Bruger USB

Ikon

(MIDI) (MIDI) (Audio)

Delete (Slet) Sletter den valgte melodi.   

Copy (Kopiér) Kopierer eller flytter den valgte MIDI-melodi til "User" (Bruger) eller 
"USB".
En MIDI-melodi i kategorien "User" (Bruger) på instrumentet kan kun 
kopieres eller flyttes til mappen "USER FILES" (Brugerfiler) på et USB-
flashdrev. En MIDI-melodi på et USB-flashdrev kan kopieres/flyttes til 
brugerkategorien på instrumentet. 

  –

Move (Flyt)   –

MIDI to Audio 
(MIDI til lyd)

Konverterer den valgte MIDI-melodi til en lydmelodi under afspilning.
Denne handling er stort set den samme, som udføres i forbindelse med 
lydindspilning, hvilket giver dig mulighed for at indspille det, du spiller på 
tangenterne, og anden lydinput via Bluetooth eller [AUX IN]-stikket osv.

  –

Rename 
(Omdøb)

Ændrer navnet på den valgte melodi.   

Delete All 
(Slet alle)

Sletter alle melodier i mappen, som indeholder den valgte melodi.
Når en melodi i kategorien "User" (Bruger) er valgt, slettes alle melodier 
i "User". Når en melodi i kategorien "USB" er valgt, slettes alle melodier 
i mappen "USER FILES" (Brugerfiler) på det tilsluttede USB-flashdrev.

BEMÆRK
Melodierne i mappen, der ligger i mappen "USER FILES" på USB-flashdrevet, slettes ikke.

  

MelodinavnIkon

Kategorinavn

Instrument

USB-flashdrev

Bruger

Kan kopieres/flyttes.

Kan kopieres/flyttes.

Grundtone

Mappen 
USER FILES
CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Referencevejledning 12



Song-menuen
4. Udfør den valgte handling.

• Når "Delete" (Slet), "Copy" (Kopiér), "Move" (Flyt), "MIDI to Audio" (MIDI til lyd) eller "Delete All" (Slet 
alle) er valgt:

4-1. Tryk på [r]-knappen for at åbne handlingsdisplayet.

4-2.  Tryk på [d]-knappen for at vælge "Execute" (Udfør), og tryk derefter på [r]-knappen for at udføre 
handlingen.

OBS!
• Sluk ikke for strømmen, og tag ikke USB-flashdrevet ud, mens handlingen udføres. Hvis du gør det, kan du risikere at miste alle dataene.
• Der vises en meddelelse, når der allerede findes en melodi med det samme navn på destinationen for kopiering/flytning. Hvis du vælger "Overwrite" 

(Overskriv), mister du de tidligere oprindelige data for melodien.

• Når "Rename" (Omdøb) er valgt:

4-1. Tryk på [r]-knappen for at åbne handlingsdisplayet.

4-2. Skift navnet på den valgte melodi.
Brug [l]/[r]-knapperne til at flytte markøren (understreget), og brug derefter [u]/[d]-knapperne til at ændre tegnet på den aktuelle 
markørposition. Hvis du vil slette tegnet på den aktuelle markørposition, skal du trykke på [REC]-knappen.
Et melodinavn kan bestå af op til 46 tegn. Du kan få vist tegn, der ikke kan være på displayet, og som ikke er synlige, ved at flytte 
markøren ved hjælp af [l]/[r]-knapperne.

BEMÆRK
Du kan finde flere oplysninger om, hvilke tegntyper du kan bruge til et melodinavn, under "Utility" > "Language" (Hjælpeprogram > Sprog) på side 26 i 
System-menuen.

4-3. Tryk på [MENU]-knappen for faktisk at omdøbe melodien.
OBS!
Sluk ikke for strømmen, og tag ikke USB-flashdrevet ud, mens handlingen udføres. Hvis du gør det, kan du risikere at miste alle dataene.

Redigering af den valgte MIDI-melodi

Fra "Edit" (Rediger) i Song-menuen (Melodi) kan du ændre dataene for den valgte MIDI-melodi i kategorien "User" (Bruger) eller "USB" og 
overskrive den.

Quantize (tilpasning af timingen af tonerne)
Med denne funktion kan du tilpasse timingen af hver tone i den valgte MIDI-melodi. Hvis du f.eks. indspiller musikfiguren nedenfor, spiller du den 
måske ikke fuldstændigt præcist, og dit spil kan have været en smule foran eller bagefter den præcise timing. Kvantisering er en praktisk måde at 
korrigere for dette på.

1. Vælg den ønskede MIDI-melodi, der skal redigeres.

2. Vælg "Edit" > "Quantize" (Rediger > Kvantisering) i Song-menuen (Melodi).

3. Angiv værdien "Quantize" (Kvantisering) til de laveste toner i MIDI-melodien.

Markør
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• Indstillinger: • Eksempel på en kvantisering af en 1/8-node

De tre indstillinger, der er markeret med en stjerne (*), er særligt anvendelige, fordi det med dem er muligt at kvantisere efter to forskellige værdier samtidig. 
Hvis der f.eks. både er "almindelige" ottendedele og ottendedelstrioler i samme stemme, og du kvantiserer med værdien en ottendedel, vil alle ottendedelsnoder 
i stemmen blive kvantiseret til "almindelige" ottendedele, så alle de trioliserede forsvinder. Hvis du derimod kvantiserer med værdien ottendedelsnode + 
ottendedelstriol, kvantiseres både de "almindelige" og de trioliserede ottendedele korrekt.

4. Angiv værdien "Strength" (Styrke), som bestemmer, i hvor høj grad noderne kvantiseres.
En indstilling til 100 % producerer nøjagtig timing. Hvis der vælges en værdi under 100 %, flyttes noderne mod de angivne 
kvantiseringstaktslag i henhold til den angivne procentdel. Hvis du anvender mindre end 100 % kvantisering, kan du bevare 
en del af den "menneskelige" følelse i indspilningen.

5. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at gemme de redigerede data.
OBS!
Hvis du trykker på [r]-knappen, overskrives dataene for den valgte MIDI-melodi. Pas på, at du ikke mister dine vigtige data.

Track Delete (sletning af data for et bestemt spor)
Med denne funktion kan du slette data for et bestemt spor fra den valgte MIDI-melodi.

1. Vælg den ønskede MIDI-melodi, der skal redigeres.

2. Vælg "Edit" > "Track Delete" (Rediger > Slet spor) i Song-menuen (Melodi).

3. Vælg det spor, du vil slette, under "Track" (Spor).

På displayet til valg af spor angiver mærket "*" det spor, som indeholder dataene. Hvis du vil tjekke de indspillede data, skal 
du afspille dem fra "Others" > "Track Listen" (Andre > Lyt til spor) i Song-menuen (Melodi) (side 11).

1/4................

1/8................

1/16.............

1/6................

1/12.............

1/24.............

1/8+1/12.........

1/16+1/24.......

1/32.............

1/16+1/12.......

fjerdedelsnode

fjerdedelstriol

ottendedelsnode

ottendedelstriol

sekstendedelsnode

sekstendedelstriol

toogtredivtedelsnode

ottendedelsnode + ottendedelstriol*

sekstendedelsnode + ottendedelstriol*

sekstendedelsnode + sekstendedelstriol*

Oprindelige data

Kvantiseringens styrke = 100 %

Kvantiseringens styrke = 50 %

Længden af en fjerdedelsnode
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Song-menuen
4. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at gemme de redigerede data.
OBS!
Hvis du trykker på [r]-knappen, overskrives dataene for den valgte MIDI-melodi. Pas på, at du ikke mister dine vigtige data.

Tempo Change (ændring af tempoværdien)
Med denne funktion kan du ændre tempoværdien af den valgte MIDI-melodi og overskrive dataene.

1. Vælg den ønskede MIDI-melodi, der skal redigeres.

2. Tryk på [TEMPO]-knappen for at åbne Tempo-displayet, og indstil værdien til det ønskede 
tempo.

3. Vælg "Edit" > "Tempo Change" (Rediger > Temposkift) i Song-menuen (Melodi).

4. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at gemme de redigerede data.
OBS!
Hvis du trykker på [r]-knappen, overskrives dataene for den valgte MIDI-melodi. Pas på, at du ikke mister dine vigtige data.

Voice Change (ændring af lyden af et bestemt spor)
Med denne funktion kan du ændre lyden af et bestemt spor i den valgte MIDI-melodi.

1. Vælg den ønskede MIDI-melodi, der skal redigeres.

2. Vælg den ønskede lyd.

3. Vælg "Edit" > "Voice Change" (Rediger > Lydskift) i Song-menuen (Melodi).

4. Vælg det spor, du vil ændre lyden for, under "Track" (Spor).

På displayet til valg af spor angiver mærket "*" det spor, som indeholder dataene. Hvis du vil tjekke de indspillede data, skal 
du afspille dem fra "Others" > "Track Listen" (Andre > Lyt til spor) i Song-menuen (Melodi) (side 11).

5. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at gemme de redigerede data.
OBS!
Hvis du trykker på [r]-knappen, overskrives dataene for den valgte MIDI-melodi. Pas på, at du ikke mister dine vigtige data.
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Metronome/Rhythm-menuen

Med Metronome/Rhythm-menuen (Metronom/rytme) kan du indstille parametre, der er relateret til metronom og rytme, f.eks. 
taktart for parametre relateret til afspilning af metronom og rytme.

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til 
at vælge den ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling

Volume 
(Volumen)

Bestemmer volumenen af metronom eller rytme. Dette giver dig 
mulighed for at justere volumenbalancen mellem det, du spiller 
på tangenterne, og metronom-/rytmeafspilningen.

0-127 82

Bell 
(Klokke)

Bestemmer, om klokkelyden afspilles ved første taktslag for den 
angivne taktart.

On (Til), Off (Fra) Off (Fra)

Time Sig.
(Time 
Signature) 
(Taktart)

Bestemmer taktarten for metronomen. Du finder flere 
oplysninger under "Indstilling af taktart og tempo til at matche 
dine noder" (side 17).

2/2, 3/2, 1/4, 2/4, 3/4, 
4/4, 5/4, 6/4, 7/4, 3/8, 
6/8, 7/8, 9/8, 12/8

4/4
(Til MIDI-melodier, 
varierer afhængigt af 
den valgte melodi)

BPM Bestemmer, om tonetypen for tempoindikationen på Tempo-
displayet bliver påvirket af metronomens taktart overfor eller 
ej (fjerdedelsnode). Når "Time Sig." er valgt, vises nævneren 
for taktarten som tonetypen for tempoindikationen. (Den 
punkterede fjerdedelsnode vises kun som tonetypen for 
tempoindikationen, når taktarten er indstillet til "6/8", "9/8" 
eller "12/8").

Time Sig. (Taktart), 
Crotchet 
(Fjerdedelsnode)

Time Sig. (Taktart)

Intro Bestemmer, om introen afspilles, før rytmefiguren starter.

BEMÆRK
Under melodiafspilning kan introen ikke afspilles, selvom du starter rytmen med 
denne parameter aktiveret.

On (Til), Off (Fra) On (Til)

Ending 
(Afslutning)

Bestemmer, om slutningen afspilles, før rytmefiguren stopper. On (Til), Off (Fra) On (Til)

SyncStart 
(Start 
synkroni- 
sering)

Når denne parameter er indstillet til "On", kan du også starte 
rytmeafspilningen ved at trykke på en tangent på klaviaturet.
Hvis du trykker på [RHYTHM]-knappen (Rytme), når denne 
funktion er slået til, indstilles Synchro Start til Standby og 
får [RHYTHM]-knappen til at blinke. I denne status startes 
rytmeafspilning ved tryk på en vilkår tangent.

On (Til), Off (Fra) Off (Fra)

Bass (Bas) Bestemmer, om automatisk basakkompagnement for rytme 
er slået til eller fra.

On (Til), Off (Fra) On (Til)
CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Referencevejledning 16



Metronome/Rhythm-menuen
Indstilling af taktart og tempo til at matche dine noder

Prøv at indstille taktart og tempo til at matche dine noder. Hvis du indstiller "Bell" (Klokke) til "On", fremhæves det første taktslag i 
den angivne taktart med en klokkelyd.

1. Vælg den ønskede taktart under "Time Sig." i Metronome/Rhythm-menuen (Metronom/Rytme).

2. Tryk på [TEMPO]-knappen for at få vist Tempo-displayet.

3. Brug [l]/[r]-knapperne til at indstille tempoet.
"Note type=tempo value" (Tonetype=tempoværdi) vises på Tempo-displayet. Afhængigt af den taktart, du indstiller i trin 1, 
varierer tonetypen og tempoet på følgende måde.

BEMÆRK
• Tonetypen er fastsat til en fjerdedelsnode, når "BPM"-parameteren i "Metronome/Rhythm"-menuen (Metronom/rytme) (side 16) er indstillet til "Crotchet" 

(Fjerdedelsnode), uanset hvilken taktart du har indstillet.
• Hvis du vælger en melodi, ændres taktarten og tempoet til dem i den valgte melodi.

Taktart Tonetype 
(Længden af ét taktslag)

Indstillingsområde

2/2, 3/2 Halvnode
3-250

1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4 Fjerdedelsnode
5-500

6/8, 9/8, 12/8 Punkteret fjerdedelsnode
4-332 (kun lige numre)

3/8, 7/8 Ottendedelsnode
10-998 (kun lige tal), 999

Tempo

Taktart

Tonetype
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Recording-menuen

Med Recording-menuen (Indspilning) kan du indstille detaljerede parametre relateret til MIDI-indspilning. Disse indstillinger 
anvendes ikke på Lydindspilning.

Genindspilning af en del af en MIDI-melodi

Du kan genindspille en del af det angivne spor i en allerede indspillet MIDI-melodi. Hvis du vil lytte til dataene for hvert spor, 
skal du afspille dem fra "Others" > "Track Listen" (Andet > Lyt til spor) i Song-menuen (Melodi) (side 11).

1. Indstil de parametre, der bestemmer, hvordan indspilningen starter og stopper, i Recording-
menuen (Indspilning).

• Indspillede data for hver kombination af indstillingerne "RecStart" og "RecEnd" (Start indspilning 
og Stop indspilning)

2. Vælg den ønskede MIDI-melodi, der skal indspilles.

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at 
vælge den ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling

RecStart 
(Start 
indspilning)

Disse parametre angiver timingen for start og stop af 
overskrivning af data, når der indspilles til en eksisterende MIDI-
melodi. Du finder flere oplysninger under "Genindspilning af en 
del af en MIDI-melodi" nedenfor.

Normal, KeyOn 
(Tangent til)

Normal

RecEnd 
(Stop 
indspilning)

Replace (Erstat), 
PunchOut (Stempl ud)

Replace (Erstat)

RecRhythm 
(Indspil 
rytme)

Bestemmer, om rytmeafspilning indspilles eller ej i MIDI-
indspilning. Når denne parameter er indstillet til "On", indspilles 
rytmestemmer til spor 9 til 11.

On (Til), Off (Fra) On (Til)

RecStart 
(Start 
indspilning)

Normal De allerede indspillede data erstattes af de nye, lige så snart indspilningen går i gang.

KeyOn 
(Tangent til)

De allerede indspillede data bevares, indtil du trykker på en tangent, og den faktiske 
indspilning starter, når du trykker på en tangent.

RecEnd 
(Stop 
indspilning)

Replace 
(Erstat)

Data efter det punkt, hvor du stopper indspilningen, vil også blive slettet.

PunchOut 
(Stempl ud)

Data efter det punkt, hvor du stopper indspilningen, vil blive bevaret.

Normal/Replace
(Normal/Erstat)

Normal/PunchOut:
(Normal/Stempl ud)

KeyOn/Replace
(Tangent til/Erstat)

KeyOn/PunchOut
(Tangent til/
Stempl ud)

Start overskrivning af indspilning Stop indspilning

Start overskrivning af indspilning Stop indspilning

Start afspilning af oprindelige data
Spil på klaviaturet for at starte 
overskrivning af indspilningen. Stop indspilning

Start afspilning af oprindelige data
Spil på klaviaturet for at starte 
overskrivning af indspilningen. Stop indspilning

Nye data Ingen data

Nye data Oprindelige data

Oprindelige data Ingen data

Oprindelige data

Nye data

Nye data Oprindelige data
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Recording-menuen
3. Angiv det startpunkt, hvorfra du vil genindspille.

Brug [l]/[r]-knapperne til at flytte afspilningspositionen (taktnummer) til det ønskede punkt. Du kan også trykke på [PLAY/
PAUSE]-knappen for at starte afspilningen og derefter trykke på [PLAY/PAUSE]-knappen igen lige lidt før det ønskede punkt.
Du kan om nødvendigt angive indstillingerne (lyd og andre parametre).

4. Tryk på [REC]-knappen, og hold den nede i et sekund for at åbne en liste over de melodier, der 
kan indspilles til, og vælg derefter igen den melodi, du valgte i trin 2.

5. Brug [l]/[r]-knapperne til at vælge et spor til genindspilning.

6. Spil på klaviaturet, eller tryk på [PLAY/PAUSE]-knappen for at starte indspilningen.

7. Tryk på [REC]-knappen for at stoppe indspilningen.

8. I displayet "Confirm" (Bekræft) skal du vælge "Save" (Gem) for at gemme dataene.
Når dataene er gemt, skal du trykke på [PLAY/PAUSE]-knappen for at lytte til den indspillede musik.
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System-menuen

Med System-menuen kan du angive de samlede indstillinger for hele instrumentet, formatere USB-flashdrevet, sikkerhedskopiere 
instrumentets indstillinger og meget mere.

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling

Bluetooth Bluetooth Slår Bluetooth-funktionen til/fra. Du skal slå denne 
funktion til for at slutte instrumentet til en enhed med 
Bluetooth, f.eks. en smartphone.

BEMÆRK
Instrumentet har muligvis ikke Bluetooth-funktion afhængigt af, 
i hvilket land du købte produktet.

On (Til), Off (Fra) On (Til)

Pairing (Parring) Til registrering (parring) af lydafspilleren med Bluetooth. 
Denne parameter vises, når "Bluetooth" ovenfor er 
indstillet til "On" (Til).
Hvis du trykker på [r]-knappen, indstilles instrumentet 
til standby til parring. Dette er den samme status, som 
når du holder [ ]-knappen (Bluetooth) nede (på CLP-
885/CLP-875/CLP-895GP) eller [MENU]-knappen (på 
CLP-845/CLP-835/CLP-865GP) i 3 sekunder. Du kan 
finde detaljer om, hvordan du slutter instrumentet til en 
lydafspiller med Bluetooth, i Brugervejledningen.

BEMÆRK
Der kan kun sluttes én smartenhed til dette instrument ad gangen 
(omend op til 8 smartenheder kan parres med instrumentet). Når 
parring med den niende smartenhed er gennemført, vil 
parringsdataene for den ældste tilslutningsdato blive slettet.

– –

Tuning 
(Stemning)

Master Tune 
(Overordnet 
finstemning)

Finstemmer tonehøjden for hele klaviaturet. Denne 
funktion er nyttig, når du spiller på instrumentet 
sammen med andre instrumenter eller med musik 
på cd.

BEMÆRK
Disse indstillinger anvendes ikke for trommesætslyde eller 
lydmelodier. Indstillingerne kan heller ikke indspilles i en MIDI-
melodi.

(A3=) 414,8 Hz-
466,8 Hz (ca. 0,2 Hz 
trin)

(A3=) 440,0 Hz

Scale Tune 
(Skalastemning)

Moderne akustiske pianoer er næsten altid stemt i en 
ligesvævende stemning, som opdeler en oktav i tolv 
lige store intervaller. Dette instrument benytter også 
den ligesvævende stemning, men kan ændres til at 
spille i historiske stemninger, som blev brugt i det 16. 
til 19. århundrede.
• Equal (Equal Temperament) (Ligesvævende stemning): En 

oktav er inddelt i tolv lige store intervaller. Dette er i dag den 
mest populære stemning af et piano.

• PureMajor, PureMinor (Ren dur, Ren mol): Som følge af 
naturlige overtoner giver de tre durakkorder med disse 
skalaer en smuk, ren lyd.

• Pythag. Pythagorean (Pythagoræisk): Denne skala blev 
udarbejdet af den græske filosof Pythagoras og er lavet over 
en række rene kvinter, som angiver intervallerne i en oktav. 
Tertsen i dette system virker ikke altid korrekt, men kvarten og 
kvinten er smukke og passer godt til nogle soloer.

• MeanTone (Middeltone): Denne skala blev lavet som en 
forbedring af den pythagoræiske skala. Man fik den store terts 
til at stemme bedre. Den var især populær fra det 16. til det 
18. århundrede. Denne skala blev bl.a. brugt af Händel.

• Werck. (Werckmeister), Kirnberger: I disse skalaer er 
middeltoneskalaen og den pythagoræiske skala kombineret 
på forskellige måder. I disse skalaer bliver det indtryk og den 
stemning, der fremkaldes af melodier, ændret ved 
modulering. De blev ofte brugt på Bachs og Beethovens tid. 
De anvendes desuden ofte til at gengive den tids musik på 
cembalo.

Equal (Ligesvævende), 
PureMajor (Ren dur), 
PureMinor (Ren mol), 
Pythag. (Pythagoræisk), 
MeanTone (Middeltone), 
Werck. (Werckmeister), 
Kirnberger

Equal (Ligesvævende)

Base Note 
(Grundtone)

Når Skalastemning er indstillet til andet end "Equal" 
(Ligesvævende), skal du indstille grundtonen. Hvis 
grundtonen ændres, transponeres klaviaturets 
tonehøjde, men tonernes oprindelige tonehøjde i 
forhold til hinanden forbliver den samme.

C, C♯, D, E♭, E, F, F♯, G, 
A♭, A, B♭, B

C
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System-menuen
Keyboard 
(Klaviatur)

Touch (Anslag) Bestemmer, hvordan lyden reagerer på dit anslag. 
• Soft 2 (Lav 2): Frembringer en relativt høj volumen selv med 

let spillestyrke.
• Soft 1 (Lav 1): Tangenterne afgiver stor volumen med et 

moderat anslag.
• Medium (Middel): Almindelig anslagsfølsomhed.
• Hard 1 (Høj 1): Tangenterne skal slås mellemkraftigt an for 

at afgive kraftig volumen.
• Hard 2 (Høj 2): Kræver stærkt spil for at frembringe høj 

volumen.
• Fixed (Fast): Volumen er fast på det niveau, som er angivet i 

"Fixed Velocity" (Fast hastighed) nedenfor, uanset hvordan du 
spiller.

BEMÆRK
Indstillingerne her indspilles ikke i en MIDI-melodi og 
overføres ikke som MIDI-meddelelser.

Soft 2 (Lav 2), Soft 1 
(Lav 1), Medium 
(Medium), Hard 1 (Høj 1), 
Hard 2 (Høj 2), Fixed 
(Fast)

Medium

Fixed Velocity 
(Fast hastighed)

Bestemmer den hastighed, som lyden spilles med, når 
"Touch" (Anslag) ovenfor er indstillet til "Fixed" (Fast).

BEMÆRK
Indstillingerne her indspilles ikke i en MIDI-melodi og overføres ikke 
som MIDI-meddelelser.

1-127 64

Duo (Firhændig 
i samme oktav)

Når denne indstilling er angivet til "On" (Til), er 
klaviaturet delt i to områder, som gør det muligt at spille 
duetter over den samme oktav. Du finder flere 
oplysninger under "Afspilning af to spillere over den 
samme oktav (Duo)" (side 28).

On (Til), Off (Fra) Off (Fra)

– Type Justerer volumenbalancen mellem venstre og højre 
højttaler, når tilstanden for firhændig i samme oktav er 
aktiveret.
• Separated (Separeret): Lyden, som spilles af den venstre 

spiller, afspilles gennem den/de venstre højttalere, og lyden, 
som spilles af den højre spiller, afspilles gennem den/de højre 
højttalere.

• Balanced (Balanceret): Lydene fra højre og venstre spiller 
afspilles gennem begge højttalere med en naturlig 
lydbalance.

BEMÆRK
Når "Separated" (Separeret) er valgt, er Reverb (Rumklang) (side 5), 
VRM (side 3) og Binaural (side 23) slået fra.

Separated, Balanced 
(Separeret, balanceret)

Separated (Separeret)

Split Point 
(Splitpunkt)

Bestemmer splitpunktet (grænsen mellem områderne 
for højre hånd og venstre hånd), når Split eller 
Firhændig i samme oktav er slået til. Området for 
venstre hånd indeholder den angivne tangent til 
splitpunkt.
Du kan også indstille splitpunktet ved at holde [DUAL/
SPLIT]-knappen nede og samtidigt trykke på den 
tangent, du vil indstille som splitpunkt, mens Split eller 
Firhændig i samme oktav er slået til.

A−1 – C7 F♯2 (Split), 
E3 (Firhændig i 
samme oktav)

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling
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System-menuen
Pedal 
(Pedal)

Half Pedal Point 
(Halvpedalpunkt)

Her kan du angive det punkt, som du skal trykke højre 
pedal ned til, før den tildelte effekt begynder at virke. 
Denne indstilling virker kun, når "Sustain (Cont.)"-
funktionen (side 7) (Efterklang (Kontinuerlig)) er tildelt 
den højre pedal.

-2 (virker ved det 
mindste
tryk) – 0 – +4 (virker ved 
det største tryk)

0

Soft Pedal Depth 
(Pianopedalens 
dybde)

Bestemmer, i hvor høj grad pianopedaleffekten 
anvendes. Denne parameter er kun tilgængelig for den 
pedal, hvor "Soft" (side 7) er tildelt.

1-10 5

Pitch Bend Range 
(Område for 
tonehøjde)

Bestemmer området for ændring af tonehøjden, der 
produceres via pedalen i halvtonetrin. Denne indstilling 
er kun tilgængelig for den pedal, hvor "PitchBend Up" 
(Ændring af tonehøjde op) eller "PitchBend Down" 
(Ændring af tonehøjde ned) (side 8) er tildelt.

BEMÆRK
I forbindelse med nogle lyde kan tonehøjden ikke ændres i 
overensstemmelse med det område for tonehøjdeværdien, der 
indstilles her.

0 til +12 (et tryk på 
pedalen hæver/sænker 
tonehøjden med 12 
halvtoner)

2

Play/Pause  
(Afspil/pause)

Tildeler funktionen af [PLAY/PAUSE]-knappen på 
kontrolpanelet til venstre pedal eller midterpedalen. 
Hvis der vælges en anden værdi end "Off", deaktiveres 
den funktion for den tilsvarende pedal, der blev tildelt 
under Voice (Lydmenuen) (side 7).

Off, Left, Center (Fra, 
Venstre, Midt)

Off (Fra)

Sound 
(Lyd)

Brilliance (Brillans) Justerer lydens samlede brilliance for dette instrument. 
Denne indstilling anvendes generelt på tangentlyde, 
afspilning af melodier og MIDI-input fra den eksterne 
enhed.
• Mellow 1-3 (Dæmpet): Lav og dæmpet lyd. Med stigende 

tal fås en varmere og mere dæmpet lyd.
• Normal: Standardklang.
• Bright 1-3 (Klar): Lys klang. Med stigende tal fås en lysere 

lyd.
• User (Bruger): Åbner displayet "User" (Bruger), hvor du kan 

lave dine egne brugertilpassede equalizer-indstillinger. 
EQ (Equalizer) er en 
lydprocessor, der 
opdeler 
frekvensspektret i flere 
bånd, som kan øges 
eller reduceres efter 
behov for at 
skræddersy den 
samlede frekvensgang. Dette instrument giver dig mulighed 
for at justere forstærkningen for tre frekvensbånd (Lav/
Mellem/Høj). 
• Indstillingsområde: -6 dB – 0 – +6 dB
• Standardindstilling: 0 dB

Mellow 1-3 (dæmpet), 
Normal  
Bright 1-3 (klar), User 
(bruger)

Normal

IAC (Intelligent 
akustisk styring)

Slår IAC-effekten (Intelligent akustisk styring) til eller 
fra. IAC er en funktion, som automatisk justerer og 
styrer lydkvaliteten i henhold til instrumentets samlede 
volumen. IAC virker kun på udgangssignalet fra 
instrumentets højttalere eller hovedtelefoner. Selv når 
volumen er lav, giver dette dig mulighed for at høre 
både lave og høje lyde tydeligt. Især når du anvender 
hovedtelefoner, reduceres belastningen på ørerne uden 
at hæve den samlede volumen overdrevet.

On (Til), Off (Fra) On (Til)

– Depth 
(Dybde)

Bestemmer dybden for IAC-effekten. Jo højere værdien 
er, desto tydeligere høres lave/høje lyde ved en lav 
volumen.

-3 – +3 0

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.
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System-menuen
Sound 
(Lyd)

Binaural Slår funktionen Binaural Sampling til eller fra. For 
de lyde, der har VRM-effekter, ændres lyden fra 
dette instrument til lyden af Binaural Sampling, 
når funktionen er slået til, og hovedtelefonerne er 
tilsluttet, eller lyden forstærkes med stereofonisk 
optimizer, hvilket gør det muligt at nyde en mere 
realistisk lyd.

 Binaural Sampling (kun til lydene "CFX 
Grand" og "Bösendorfer")

Binaural sampling er en metode, der anvender to 
specialmikrofoner ved musikerens øre og indspiller 
lyden fra et piano, som den er. Når du lytter til denne lyd 
og oplever effekten gennem hovedtelefonerne, får du 
en fornemmelse af at være omsluttet af lyden, som om 
den virkelig kom fra pianoet. Når en af de tilsvarende 
lyde er valgt, aktiveres Binaural Sampling-lyden 
automatisk ved tilslutning af hovedtelefonerne.

 Stereophonic optimizer (kun til lyde, der 
har VRM-effekter, undtagen "CFX 
Grand" og "Bösendorfer")

Stereofonisk optimizer er en effekt, der gengiver den 
naturlige lydafstand gennem hovedtelefoner, ligesom 
med lyden af binaural sampling. Når en af de 
tilsvarende lyde er valgt, aktiveres stereofonisk 
optimizer automatisk ved tilslutning af 
hovedtelefonerne.

BEMÆRK
• Når "Utility" > "Speaker" (Hjælpeprogram > Højttaler) 

(side 25) i System-menuen er indstillet til "On" (Til), er denne 
funktion deaktiveret, selv når hovedtelefonerne er tilsluttet.

• Når Binaural er indstillet til "On" (Til), og hovedtelefonerne er 
tilsluttet, påvirker disse effekter også lyden fra den eksterne 
højttaler, som er sluttet til AUX OUT-stikkene, eller lyden til 
lydindspilning og kan medføre usædvanlige eller unaturlige 
lyde. Hvis det sker, skal du slå denne funktion fra.

On (Til), Off (Fra) On (Til)

Volume Limiter 
(Volumenbe-
grænsning)

Slår funktionen Volumenbegrænsning til/fra. Når 
funktionen er indstillet til "On" (Til), er den 
maksimale volumen af hele lyden begrænset for 
at forhindre en overdrevet høj volumen, og ikonet 
( ) vises nederst til højre på Song-displayet 
(Melodi) eller Voice-displayet (Lyd).

On (Til), Off (Fra) Off (Fra)

– Limit 
Point 
(Græn-
sepunkt)

Bestemmer den maksimale volumen, når 
funktionen Volume Limiter 
(Volumenbegrænsning) er slået til. 
Indstillingsværdien angiver positionen af 
[VOLUME]-skyderen (MAX = 100 %). Lydstyrken 
øges ikke, selvom du flytter skyderen over dette 
punkt.

10 %-100 % 50 %

MIDI MIDI OUT  
(MIDI-UDGANG)

Bestemmer den MIDI-kanal, der bruges til 
overførsel af de MIDI-meddelelser, der er oprettet 
via spil på tangenterne, fra USB [TO HOST]-
stikket. Når Dual (Dobbelt), Split (Split) eller Duo 
(Firhændig i samme oktav) er slået til, er MIDI-
kanalerne tildelt på følgende måde.
• Spil via Højre lyd 1 = n (indstillingsværdi)

• Spil via Højre lyd 2 = n+2

• Spil via Venstre lyd = n+1

Ch1-Ch16, Off (Fra) 
(overføres ikke)

Ch1

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.
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System-menuen
MIDI MIDI IN  
(MIDI-INDGANG)

Bestemmer, hvilken del af instrumentet der styres af 
hver kanaldata for de MIDI-meddelelser, der kommer 
fra USB [TO HOST]-stikket.
• Song (Melodi): Melodistemmen styres.
• Keyboard (Klaviatur): Al spil på tangenterne styres, 

uafhængigt af indstillingen for Dobbelt/Split/Firhændig 
i samme oktav.

• R1: Spillet på tangenterne via Højre lyd 1 styres.
• R2: Spillet på tangenterne via Højre lyd 2 styres.
• L: Spillet på tangenterne via Venstre lyd styres.
• Off (Fra): Ingen af stemmerne styres.

Song (Melodi), 
Keyboard (Klaviatur), 
R1 (H1), R2 (H2), L (V), 
Off (Fra)

(For alle kanaler)
Song (Melodi)

Local Control 
(Lokal styring)

"Local Control On" (Lokal styring til) er en tilstand, hvor 
instrumentets tonegenerator frembringer lyden, når du 
spiller på klaviaturet. I "Local Control Off" (Lokal styring 
fra) er der ingen forbindelse mellem klaviaturet og 
tonegeneratoren. Der kommer altså ingen lyd fra 
instrumentet, når du spiller på klaviaturet. I stedet kan 
klaviaturdataene overføres via MIDI til en
tilsluttet MIDI-enhed eller computer, som kan producere 
lyden. Indstillingen "Local Control Off" (Lokal styring 
fra) er nyttig, når du kun vil afspille en ekstern lydkilde, 
mens du spiller på tangenterne på dette instrument.

On (Til), Off (Fra) On (Til)

Receive Param. 
(Modtage-
parameter)

Bestemmer, hvilke typer MIDI-meddelelser der kan 
modtages eller genkendes af instrumentet.

MIDI-meddelelsestyper:
Note on/off (Tone til/fra), Control Change (Kontrolændring), 
Program Change (Programændring), Pitch Bend (Ændre 
tonehøjde), System Exclusive (Eksklusiv for system)

On (Til), Off (Fra) (For alle meddelelser)
On (Til)

Transmit Param. 
(Transmissions-
parameter)

Bestemmer, hvilke typer MIDI-meddelelser der kan 
overføres fra dette instrument.

MIDI-meddelelsestyper:
Note on/off (Tone til/fra), Control Change (Kontrolændring), 
Program Change (Programændring), Pitch Bend (Ændre 
tonehøjde), System Real Time (System i realtid), System 
Exclusive (Eksklusiv for system)

On (Til), Off (Fra) (For alle meddelelser)
On (Til)

Initial Setup 
(Standardind-
stillinger)

Overfører de aktuelle indstillinger på instrumentet 
såsom lydvalg til en tilsluttet MIDI-enhed eller 
computer. Før du går i gang med at indspille dit 
pianospil på en tilsluttet MIDI-enhed eller computer, 
skal du udføre denne funktion for at indspille de aktuelle 
panelindstillinger i begyndelsen af dataene for dit spil 
på tangenterne. På den måde vælges de samme 
panelindstillinger, når det indspillede spil på 
tangenterne afspilles.
Hvis du vil bruge denne funktion, skal du "Execute" 
(Udfør) og derefter trykke på [r]-knappen for at overføre 
instrumentets indstillinger som MIDI-meddelelser.

– –

Backup 
(Sikkerheds-
kopiering)

Backup Setting 
(Indstilling for 
sikkerheds-
kopiering)

Dette giver dig mulighed for at angive, om 
indstillingerne skal bevares eller ej, når der slukkes for 
strømmen. Du finder flere oplysninger under "Valg af 
parametre, som skal fastholdes, når der slukkes for 
strømmen (Backup Setting)" (side 29).

On (Til), Off (Fra) "Voice" = Off  
(Lyd = Fra)
"Other" = On  
(Andet = Til)

Backup 
(Sikkerheds-
kopiering)

Dette giver dig mulighed for at gemme alle data og 
indstillinger for brugermelodi i instrumentet på et 
tilsluttet USB-flashdrev som en sikkerhedskopifil 
(filtypenavn: .bup). Du finder flere oplysninger under 
"Lagring af melodidataene og instrumentindstillingerne 
til USB-flashdrev (Backup)" (side 29).

– –

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.
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System-menuen
Backup 
(Sikkerheds-
kopiering)

Restore (Gendan) Dette giver dig mulighed for at indlæse en 
sikkerhedskopifil på et USB-flashdrev (filtypenavn: 
.bup) på instrumentet og gendanne brugermelodierne 
og indstillingerne. Du finder flere oplysninger under 
"Indlæsning af en sikkerhedskopifil, der er gemt på et 
USB-flashdrev, i instrumentet (Restore)" (side 30).

– –

Factory Reset 
(Fabriksind-
stillinger)

Dette giver dig mulighed for at nulstille de 
sikkerhedskopierede indstillinger til fabriksindstillingerne. 
Du finder flere oplysninger under "Gendannelse af 
fabriksindstillinger (Factory Reset)" (side 30).

– –

Utility 
(Hjælpe-
program)

Speaker (Højttaler) Giver dig mulighed for at slå instrumentets højttaler til/
fra.
• Normal: Højttalerne producerer kun lyd, når 

hovedtelefonerne er sluttet til [PHONES]-stikket.
• On (Til): Højttalerens lyd er altid til.
• Off (Fra): Højttalerens lyd er fra.

BEMÆRK
Når denne funktion er indstillet "On" (Til), er "Binaural" (side 23) 
deaktiveret.

Normal, On (Til), Off 
(Fra)

Normal

Audio Loopback 
(Lyd-loopback)

Bestemmer, om lydinput fra den tilsluttede computer 
eller smartenhed afspilles på en computer eller en 
smartenhed eller ej sammen med det, der spilles på 
instrumentets tangenter.
Hvis du f.eks. vil indspille lydinputtet og lyden, der 
spilles på instrumentet, ved hjælp af den tilsluttede 
computer eller smartenhed, skal du slå funktionen til. 
Hvis du kun ønsker at indspille den lyd, der afspilles på 
instrumentet, ved hjælp af computeren eller 
smartenheden, skal du slå funktionen fra.

BEMÆRK
• I denne manual henviser "lydinput" til lyddata, som sendes til 

instrumentet fra tilsluttede eksterne enheder ved hjælp af en af 
disse metoder: Funktionen USB-lydinterface, funktionen 
Bluetooth-lyd, [AUX IN]-stik eller Wi-Fi.

• Lyden kan sendes til en enhed, der er tilsluttet via Bluetooth eller 
[AUX IN]-stikket.

• Med lydindspilning på dette instrument indspilles lydinputtet fra 
den eksterne enhed, når funktionen er slået til, og lyden indspilles 
ikke, når funktionen er slået fra. Men når enhederne er forbundet 
via Bluetooth Audio eller [AUX IN]-stikket, indspilles inputlydene 
altid, uanset om Lyd-loopback er slået til eller fra.

On (Til), Off (Fra) On (Til)

Auto Power Off 
(Automatisk 
slukning)

Giver dig mulighed for at indstille den tid, der går, før 
strømmen slukkes af funktionen Automatisk slukning. 
Du deaktiverer funktionen Automatisk slukning ved at 
vælge "Off" (Fra).
Du kan også deaktiverer funktionen Automatisk 
slukning ved at slukke for strømmen, mens du holder 
den dybeste tangent på klaviaturet nede.

OBS!
Alle data, der ikke er gemt, går tabt, hvis der slukkes for 
strømmen. Sørg for at gemme dine data, før dette sker.

Off, 5, 10, 15, 30, 60, 
120 (minutter)

15

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.
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System-menuen
Utility 
(Hjælpe-
program)

USB Properties 
(Egenskaber for 
USB)

Viser mængden af ledig plads og hele hukommelsen 
på det USB-flashdrev, der er tilsluttet USB [TO 
DEVICE]-stikket. 

– –

USB Autoload 
(Automatisk 
indlæsning 
i forbindelse 
med USB)

Når denne parameter er indstillet til "On", kan den 
melodi, der er gemt i rodmappen, automatisk vælges 
(vises på displayet), lige så snart USB-flashdrevet 
tilsluttes USB [TO DEVICE]-stikket.

On (Til), Off (Fra) Off (Fra)

USB Format (USB-
format)

Dette giver dig mulighed for at formatere eller 
initialisere det USB-flashdrev, der er tilsluttet USB [TO 
DEVICE]-stikket. Du begynder at formatere ved at 
vælge "Execute" (Udfør) og derefter trykke på [r]-
knappen. Når formateringen er fuldført, vises en 
meddelelse, og instrumentet vender tilbage til Utility-
displayet (Hjælpeprogram) efter et stykke tid.

OBS!
• Når du formaterer, slettes alle de data, der er gemt på USB-

flashdrevet. Gem vigtige data på en computer eller en anden 
lagerenhed.

• Du må ikke slukke for strømmen eller tage USB-flashdrevet 
ud, mens "Executing" vises på displayet. Hvis du gør det, kan 
det beskadige USB-flashdrevet og dataene.

– –

Contrast (Kontrast) Justerer kontrasten i displayet. -8 – +8 0

Touch Panel 
Sound (Lyd på 
berøringspanel)
(CLP-885/CLP-875/
CLP-895GP)

Kontrolpanelet afgiver en praktisk bekræftelseslyd, 
når det betjenes. Dette kan slås til/fra her.

On (Til), Off (Fra) On (Til)

Auto Backlight Off 
(Automatisk 
slukning af 
baggrunds-
belysning)
(CLP-885/CLP-875/
CLP-895GP)

Gør det muligt at indstille den tid, der går, før 
kontrolpanelet og displayet slukkes, eller indstille, 
at de skal forblive tændt (indstillingen "Off" (Fra)).

Off (Fra), 10, 20, 30, 60 
(sekunder)

30

Language (Sprog) Bestemmer den type tegn, der vises på displayet for 
henholdsvis systemet (generel visning ud over 
melodinavn) og melodierne (melodinavn).

Tegnliste: 

International, Japanese 
(japansk)

International

Version Viser dette instruments modelnavn og firmware-
version.

– –

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.

Parameter Beskrivelse Indstillingsområde Standardindstilling

Mængden 
af hele 
hukommelsen

Mængden 
af ledig plads

International

Japanese (japansk)
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System-menuen
Utility 
(Hjælpe-
program)

Wireless LAN 
(Trådløst LAN)
* Dette vises kun, når den 

trådløse USB LAN-
adapter er tilsluttet.

Dette giver dig mulighed for at angive indstillinger for 
trådløst LAN (Wi-Fi). Du finder flere oplysninger på 
side 31.

– –

Wire-
less 
LAN 
Option 
(Mulig-
heder 
for  
trådløst 
LAN)
* Dette 

vises 
kun, når 
den tråd-
løse USB 
LAN-
adapter 
er tilslut-
tet.

Wireless 
LAN 
Mode  
(Tilstand 
for  
trådløst 
LAN)

Bestemmer, om der skal bruges et adgangspunkt 
(Tilstand for infrastruktur) eller ej (Tilstand for 
adgangspunkt).

Infrastructure Mode 
(Tilstand for 
infrastruktu), 
Accesspoint Mode 
(Tilstand for 
adgangspunkt)

Infrastructure Mode 
(Tilstand for 
infrastruktur)

Initialize 
(Initiali-
sering)

Initialiserer indstillingerne for trådløst LAN. Vælg 
"Execute" (Udfør), og tryk derefter på [r]-knappen 
for at initialisere indstillingerne.

– –

Detail 
(Detalje)

Viser værtsnavnet, MAC-adressen og statussen af 
netværket. Værtsnavnet kan ændres. Metoden til 
at indtaste tegnene er den samme som "Rename" 
(Omdøb) af melodifilen (side 12).

(Værtsnavn)
Op til 57 tegn (halv 
størrelse), inklusive 
alfanumeriske tegn, 
tegnet "_" 
(understregningstegn) 
og "-" (bindestreg).

(Værtsnavn)
CLP-***-xxxxxx 
(de sidste 6 tal  
i MAC-adressen)

Betjening:
Tryk på [MENU]-knappen flere gange for at vælge Voice-menuen (Lyd), og brug derefter [u]/[d]/[l]/[r]-knapperne til at vælge den 
ønskede parameter og skifte indstillingerne.
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System-menuen
Afspilning af to spillere over den samme oktav (Duo)

Ved hjælp af denne funktion kan to personer spille på instrumentet samtidig – en på venstre halvdel og en på højre. Dette er 
praktisk, når der skal øves duetter over den samme oktav.

1. Slå funktionen Duo (Firhændig i samme oktav) til via "Keyboard" > "Duo" (Klaviatur > 
Firhændig i samme oktav) i System-menuen.
På CLP-885/CLP-875/CLP-895GP bliver [DUAL/SPLIT]-knappen orange, og på CLP-845/CLP-835/CLP-865GP lyser [DUAL/
SPLIT]-knappen. Klaviaturet inddeles i to sektioner, hvor E3-tangenten er splitpunktet. Splitpunktstangenten er inkluderet 
i venstre spillers område. 

BEMÆRK
Splitpunktet kan indstilles via "Keyboard" > "Split Point" (Klaviatur > Splitpunkt) i System-menuen (side 21).

Pedalfunktionen skifter som følger:

• Højre pedal: Dæmperpedal til højre spiller

• Midterpedal: Dæmperpedal til både højre og venstre spiller
• Venstre pedal: Dæmperpedal til venstre spiller

2. Tryk på [EXIT]-knappen efter behov for at åbne Voice-displayet, og brug derefter [l]/[r]-
knapperne eller [VOICE]-knappen til at vælge den ønskede lyd.
Når Duo (Firhændig i samme oktav) er slået til, vises [Duo] på Voice-displayet (Lyd). Der kan kun vælges én (delt) lyd for 
både venstre og højre spiller.

3. Spil på klaviaturet.
Som standard afspilles lyden fra den venstre spillers område fra venstre højttaler og lyden fra højre spillers område fra højre 
højttaler.

BEMÆRK
•  Hvis du indstiller "Keyboard" > "Duo-Type" (Klaviatur > Typen Firhændig i samme oktav) i System-menuen (side 21) til "Balanced" (Balanceret), kan de lyde, 

der spilles af både højre og venstre spiller, afspilles via begge højttalere med en naturligt balanceret lyd.
• Når Duo (Firhændig i samme oktav) er slået til, anvendes VRM-effekten (side 3) ikke. Hvis du indstiller "Keyboard" > "Duo-Type" (Klaviatur > Firhændig i 

samme oktav) i System-menuen (side 21) til "Separated" (Separeret), anvendes effekterne Reverb (Rumklang) (side 5) og Binaural (Binaural) (side 23) også.

4. Tryk på [DUAL/SPLIT]-knappen for at slå Duo (Firhændig i samme oktav) fra.
BEMÆRK
Du kan også slå Duo (Firhændig i samme oktav) fra ved at trykke på en af [CFX GRAND]-, [BOSENDORFER]- eller [PIANO ROOM]-knapperne eller ved at 
vælge "Off" (Fra) på displayet under trin 1 ovenfor.

Splitpunkt E3

Venstre spiller

Svarer til C3 (mellem C)Svarer til C3 (mellem C)

Højre spiller
CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Referencevejledning 28



System-menuen
Valg af parametre, som skal fastholdes, når der slukkes for strømmen 
(Backup Setting)

Følgende data og indstillinger (kaldet sikkerhedskopidata) bevares, selv når der slukkes for strømmen. Parametrene i "Backup Setting" (Indstilling 
for sikkerhedskopiering) kan indstilles til, om indstillingerne skal bevares eller ej, når der slukkes for strømmen.

1. Åbn "Backup" > "Backup Setting" (Sikkerhedskopiering > Indstilling for sikkerhedskopiering) 
i System-menuen.

2. Vælg "On" (Til) (for at bevare data) eller "Off" (Fra) (for ikke at bevare data) for "Voice" (Lyd) og 
"Other" (Andet).

• Parametre i "Voice" (Lyd):
• Valg af lyd

• Alle parametrene ud over "Transpose" (Transponere) i Voice-menuen (Lyd)

• Parametre i "Other" (Andet):
• Song-menu (Melodi): Repeat (Gentag), Volume (Song-Keyboard) (Volumen (Melodi-klaviatur)), Volume (Audio Song) 

(Volumen (lydmelodi)), Quick Play (Hurtig afspilning), Play Track (Afspil spor)

• Metronome/Rhythm-menu (Metronomen/rytme): Volume (Volumen), Bell (Klokke), BPM (BPM), Intro (Intro), Ending 

(Slutning), Bass (Bas)

• System-menu (System): Tuning (Stemning), Keyboard (Klaviatur) (undtagen Duo (Firhændig i samme oktav) og Duo 

Type (Typen Firhændig i samme oktav)), Pedal, Sound (Lyd), MIDI

3. Når du har angivet indstillingerne, skal du trykke på [EXIT]-knappen for at afslutte System-
menuen.

Lagring af melodidataene og instrumentindstillingerne til USB-flashdrev 
(Backup)

Melodidataene, der er gemt under kategorien "User" (Bruger) og instrumentindstillingerne kan gemmes på et USB-flashdrev som en 
sikkerhedskopifil (filtypenavn: .bup). Denne sikkerhedskopifil kan indlæses til instrumentet via funktionen til gendannelse (side 30) til fremtidig 
brug. Du kan finde flere oplysninger om bestemte data, som er indeholdt i sikkerhedskopifilen, under "Sikkerhedskopidata" ovenfor.

OBS!
• Hvis den samme sikkerhedskopifil (clp-***.bup) allerede er gemt på USB-flashdrevet, overskrives eller erstattes denne fil med den nye fil med denne handling.
• Det kan tage 1-2 minutter at fuldføre denne handling. Undlad at slukke for strømmen, mens "Executing" (Udfører) vises. Hvis du gør det, kan det beskadige dataene.

1. Tilslut USB-flashdrevet til USB [TO DEVICE]-stikket.

2. Åbn "Backup" > "Backup" (Sikkerhedskopiering > Sikkerhedskopiering) i System-menuen.

3. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at begynde at gemme data på USB-
flashdrevet.
Når dataene er gemt, vises en meddelelse, som angiver, at handlingen er fuldført.

Sikkerhedskopidata
• MIDI-melodier gemt under kategorien "User" (Bruger)

• Følgende indstillinger i System-menuen
- "Bluetooth" > "Bluetooth" (side 20)

- "Keyboard" > "Duo-Type" (Klaviatur > Typen Firhændig i samme 

oktav) (side 21)

- "Utility" (Hjælpeprogram) (side 25)

- Parametre indstillet til "On" (Til) i "Backup" > "Backup Setting" 

(Sikkerhedskopiering > Indstilling for sikkerhedskopiering)
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Indlæsning af en sikkerhedskopifil, der er gemt på et USB-flashdrev, 
i instrumentet (Restore)

Når du indlæser sikkerhedskopifilen (filtypenavn: .bup), der er gemt på USB-flashdrevet, kan brugermelodier og 
instrumentindstillingerne gendannes.

OBS!
• Hvis der er melodier under "User" (Bruger) på instrumentet, slettes alle disse melodier, når gendannelseshandlingen udføres. Sørg for at flytte 

vigtige data til USB-flashdrevet fra "File" > "Move" (Fil > Flyt) (side 10) i Song-menuen (Melodi), før du udføres denne handling.
• Det kan tage 1-2 minutter at fuldføre denne handling. Undlad at slukke for strømmen, mens "Executing" (Udfører) vises. Hvis du gør det, kan 

det beskadige dataene.

1. Slut USB-flashdrevet med sikkerhedskopifilen til USB [TO DEVICE]-stikket.

2. Åbn "Backup" > "Restore" (Sikkerhedskopiering > Gendan) i System-menuen.

3. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at begynde at indlæse dataene til 
instrumentet.
Der vises en meddelelse, som angiver, at handlingen er fuldført, og instrumentet genstartes derefter.

Gendannelse af fabriksindstillinger (Factory Reset)

Funktionen Fabriksindstillinger initialiserer indstillingerne for instrumentet til fabriksindstillingerne. De MIDI-melodier, der er gemt 
i kategorien "User" (Bruger), og oplysninger om Bluetooth-parring mistes ikke, når nulstilling til fabriksindstillingerne udføres.

OBS!
Undlad at slukke for strømmen, mens "Executing" (Udfører) vises på displayet. Hvis du gør det, kan det beskadige dataene.

1. Åbn "Backup" > "Factory Reset" (Sikkerhedskopiering > Nulstilling til fabriksindstillinger) fra 
System-menuen.

2. Vælg "Execute" (Udfør), og tryk på [r]-knappen for at starte initialisering.
Der vises en meddelelse, som angiver, at handlingen er fuldført, og instrumentet genstartes derefter.

BEMÆRK
Alle MIDI-melodier, der er gemt under "User" (Bruger), kan slettes via "File" > "Delete All" (Fil > Slet alle) i Song-menuen (Melodi). Du finder flere oplysninger under 
"Styring af melodifilerne" (side 12).

Alternative metoder til nulstilling til fabriksindstillingerne 
Du kan også gendanne fabriksindstillingerne via følgende metode.
Tryk på [P]-kontakten (Standby/On), mens du holder den højeste tangent 
nede, for at tænde for strømmen.

Højeste tangent

[P]-kontakt (Standby/On) 
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Indstilling af trådløst LAN (Wi-Fi)

Hvis du vil slutte dette instrument til en smartenhed via trådløst LAN (Wi-Fi), skal du bruge den trådløse USB LAN-adapter  
UD-WL01, som sælges separat.

OBS!
Tilslut ikke dette produkt direkte til offentlig Wi-Fi og/eller internettjeneste. Produktet må kun forbindes med internettet gennem en router med 
effektiv adgangskodebeskyttelse. Kontakt producenten af din router for at få oplysninger om den bedste sikkerhedspraksis.

BEMÆRK
Den trådløse USB LAN-adapter (UD-WL01) er muligvis ikke tilgængelig afhængigt af dit område.

1. Slut den trådløse USB LAN-adapter UD-WL01 til USB [TO DEVICE]-stikket på instrumentet.

2. Vælg tilslutningstilstanden via "Utility" > "Wireless LAN Option" > "Wireless LAN Mode" 
(Hjælpeprogram > Muligheder for trådløst LAN > Tilstand for trådløst LAN) i System-menuen.

3. Angiv de nødvendige indstillinger under "Utility" > "Wireless LAN" (Hjælpeprogram > Trådløst 
LAN) i System-menuen.
De viste parametre på displayet varierer mellem "Infrastructure Mode" (Tilstand for infrastruktur) og "Accesspoint Mode" 
(Adgangspunkt). Du kan finde oplysninger om tilstanden for infrastruktur herunder og om tilstanden for adgangspunkt på 
side 32.

• For Tilstand for infrastruktur:
Vælg det ønskede netværk på listen under "Select Network" (Vælg netværk). Hvis du vil oprette forbindelse til et netværk, 
der ikke vises på listen, skal du vælge "Other" (Andet) nederst på listen. Når du vælger "Other" (Andet), skal du angive 
indstillingerne for SSID, sikkerhed og adgangskode og derefter vælge "Connect" (Tilslut) for at udføre handlingen.

Vend tilbage til "Wireless LAN"-displayet (Trådløst LAN), og angiv "Detail"-indstillinger (Detaljer) efter behov. Når du har 
angivet indstillingerne på "Detail"-displayet (Detaljer), skal du sørge for at gemme dem ved at trykke på "Save" (Gem).

Infrastructure Mode 
(Tilstand for 
infrastruktur)

Denne tilstand bruger et adgangspunkt til datakommunikation mellem den trådløse USB 
LAN-adapter (UD-WL01) og et netværk. Du kan bruge denne tilstand, når du opretter 
forbindelse til et andet netværk, mens en smartenhed er sluttet til instrumentet.

• Når adgangspunktet understøtter WPS:
Det er ikke nødvendigt at angive indstillinger på instrumentet. Tryk på WPS-knappen på 
den trådløse USB LAN-adapter i mere end 3 sekunder, og tryk derefter på WPS-knappen 
på dit adgangspunkt inden for 2 minutter.
BEMÆRK 
Du kan finde flere oplysninger om bekræftelse og ændringer af adgangspunktet i vejledningen til adgangspunktet.

• Når adgangspunktet ikke understøtter WPS (eller du ikke er sikker):
Vælg det ønskede netværk på listen over netværk på instrumentet for at oprette forbindelse.

Accesspoint Mode 
(Tilstand for 
adgangspunkt)

Denne tilstand giver dig mulighed for at oprette direkte forbindelse mellem den trådløse USB 
LAN-adapter og en smartenhed uden at skulle bruge et adgangspunkt. Du kan bruge denne 
tilstand, når der ikke er noget tilgængeligt adgangspunkt til at oprette forbindelse til 
instrumentet, eller når det ikke er nødvendigt at oprette forbindelse til et andet netværk, 
mens en smartenhed er sluttet til instrumentet.

Parameter Beskrivelse Indstillingsområde Standar-
dindstilling

Select 
Network 
(Vælg 
Netværk)

(Netværk) Opretter forbindelse til et adgangspunkt ved 
at vælge netværket. Hvis et netværk har 
et hængelåsikon ( ), skal du indtaste 
adgangskoden. Metoden til at indtaste 
tegnene er den samme som under "Rename" 
(Omdøb) af melodifilen (side 13).

– –
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• For Tilstand for adgangspunkt:
Angiv indstillingerne for SSID, Sikkerhed, adgangskode og kanal for at bruge instrumentet som et adgangspunkt. Når du 
har angivet indstillingerne på dette display, skal du sørge for at gemme dem ved at trykke på "Save" (Gem). 

Select 
Network 
(Vælg 
Netværk)

Other 
(Andet)

SSID Angiver SSID'et. Metoden til at indtaste 
tegnene er den samme som under "Rename" 
(Omdøb) af melodifilen (side 13).

Op til 32 tegn (halv 
størrelse), 
alfanumeriske tegn, 
mærker

–

Security 
(Sikkerhed)

Angiver sikkerheden. NONE, WEP,  
WPA2-PSK(AES), WPA/
WPA2 mixed PSK

NONE

Password 
(Adgangs-
kode)

Angiver adgangskoden. Metoden til at 
indtaste tegnene er den samme som under 
"Rename" (Omdøb) af melodifilen (side 13).

Op til 64 tegn (halv 
størrelse), 
alfanumeriske tegn, 
mærker

–

Connect 
(Tilslut)

Opretter forbindelse til netværket med de 
indstillinger, der er angivet på "Other"-
displayet (Andet).

– –

Detail 
(Detalje)

DHCP Angiver detaljerede indstillinger for trådløst 
LAN. IP Address (IP-adresse), Subnet Mask 
(Undernetmaske), Gateway, DNS Server1, 
DNS Server2 kan indstilles, når DHCP er 
indstillet til Off, men ikke når DHCP er 
indstillet til On. Brug [l]/[r]-knapperne til at 
vælge hver oktet på startdisplayet, og indtast 
derefter værdien ved hjælp af [u]/[d]-
knapperne. Tryk på [MENU]-knappen for 
at færdiggøre indstillingen.

Til/fra On (Til)

IP Address  
(IP-adresse)

0.0.0.0-
255.255.255.255

0.0.0.0

Subnet Mask 
(Undernetmaske)

0.0.0.0-
255.255.255.255

0.0.0.0

Gateway 0.0.0.0-
255.255.255.255

0.0.0.0

DNS Server 1, 2 0.0.0.0-
255.255.255.255

0.0.0.0

Save (Gem) Gemmer indstillingerne på "Detail"-displayet 
(Detaljer).

– –

Parameter Beskrivelse Indstillingsområde Standardindstilling

SSID Angiver SSID som et adgangspunkt. Metoden til 
at indtaste tegnene er den samme som under 
"Rename" (Omdøb) af melodifilen (side 13).

Op til 32 tegn (halv størrelse), 
alfanumeriske tegn, mærker

ap-CLP-***-xxxxxx (de 
sidste 6 tal i MAC-
adressen)

Security 
(Sikkerhed)

Angiver Security (Sikkerhed) som et 
adgangspunkt.

NONE, WEP,  
WPA2-PSK(AES),  
WPA/WPA2 mixed PSK

NONE

Password 
(Adgangskode)

Angiver Password (Adgangskode) som et 
adgangspunkt. Metoden til at indtaste tegnene 
er den samme som under "Rename" (Omdøb) af 
melodifilen (side 13).

Op til 64 tegn (halv størrelse), 
alfanumeriske tegn, mærker

–

Channel (Kanal) Angiver kanalen som et adgangspunkt. Varierer, afhængigt af modellen af 
den trådløse USB LAN-adapter.
• Modeller til USA og Canada: 1-11
• Andre: 1-13
Når der ikke er nogen trådløs USB 
LAN-adapter tilsluttet, er 
indstillingsområdet kanalerne 1-13.

11

Parameter Beskrivelse Indstillingsområde Standar-
dindstilling
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DHCP Server 
(DHCP-server)

Angiver indstillinger relateret til IP-adressen. On (Til), Off (Fra) On (Til)

IP Address  
(IP-adresse)

192. 168. 0-255. 1-254. 192.168.0.1

Subnet Mask 
(Undernetmaske)

255.255.0.0,
255.255.128.0,
255.255.192.0,
255.255.224.0,
255.255.240.0,
255.255.248.0,
255.255.252.0,
255.255.254.0,
255.255.255.0

255.255.255.0

Save (Gem) Gemmer de indstillinger, du angiver på displayet 
"Wireless LAN" (Trådløst LAN) (i Tilstand for 
adgangspunkt).

– –

Parameter Beskrivelse Indstillingsområde Standardindstilling
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